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Use of the Designer 
The Designer  is used for creating "print layouts" and for designing templates used with the Garden 
Studio module. If a Designer  feature is applicable only to layouts or templates, the title will so 
indicate. If you do not have the optional Garden Studio module, then those areas do not apply to 
your software at all. 

Layouts are a combination of data derived from the Horticopia pictures and information plus 
artwork and data that you add you add yourself. Layouts are typically created one at a time for a 
specific plant or small set of plants. They are highly customizable and are used for applications 
ranging from POS signage to landscape design proposals. The primary features available only in 
Layouts (and not in templates) include multiple pages, and document setup. Horticopia data is 
incorporated into Layouts with the "Copy to Layout" command whose function is specific to the 
Information Window tab active at the time the "Copy to Layout" command is executed. 

Templates are a design that incorporates static data such as logos, line art, and text. Additionally, 
templates usually contain "placeholders" for Horticopia or user data that is different for each plant. 
For example, you can create a placeholder for the botanical name or for the preferred picture. In 
Garden Studio these placeholders are called fields. The template can then be applied to a list of 
plants where the information of each plant replaces the "placeholders" to produce the printed 
output. The output would typically be signs, tags, pot stickers, or single page per plant design 
proposals. All templates are for a single "label". Labels are contained of forms which define the 
arrangement of the labels on the form. A form may contain only one "label", so it's possible to have 
a letter size template. 
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Keyboard Shortcuts 

Shortcuts 

The following is a list of keyboard shortcuts that can be used from within the Designer. 

  

F1 -- Open the Designer  Help window 

F2 -- Go to the Garden Workbench 

F4 -- Open the I tem Proper ties window 

F5 -- Open the Design Preview window 

F6 -- Snap to grid 

shift + F6 -- Show grid 

F7 -- Snap to guide 

CTRL + A -- Select all 

CTRL + B -- Makes text appear bold-faced 

CTRL + I  -- Makes text appear in italics 

CTRL + U -- Makes text appear underlined 

CTRL + C -- Copy selection to clipboard 

CTRL + V -- Paste from clipboard 

CTRL + X -- Cut selection and place it in the clipboard 

CTRL + Z -- Undo last action 

CTRL + P -- Print 

CTRL + S -- Save design 

CTRL + G -- Group 

CTRL + N -- Ungroup 

CTRL + F -- Move to front 

CTRL + R -- Move to back 

CTRL + M -- Go to/from master page 

delete -- Clear or delete selection 

  

Keyboard Hints 

The following is a list of some helpful keyboard hints for using the Designer. 
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� � With a selected item, hold down the CTRL key and use the arrow buttons to "nudge" an item. 

� � When an item is selected, hold down the CTRL key and double-click on the item to open the I tem 
Proper ties window.  

� � Hold down the CTRL key to select a locked item. 

� � Hold down the shift key while creating a rectangle or rounded rectangle in order to have the 
rectangle maintain the proportions of a square. Also hold down the shift key while creating an 
ellipse to have the ellipse maintain the proportions of a circle.  
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Menus 

File Menu 

The following is a list of all the commands found on the File drop-down menu. 

� � Close Design 

The Close Design command closes the current design on which you are working. You will be 
prompted to save your work if you have made changes since the last time you saved. 

  

� � Save Design 

The Save Design command saves your work under the file name under which you have previously 
saved. 

  

� � Save Design As 

The Save Design As command saves your work as a newly saved file. You will be prompted to 
choose a file name under which to save. 

  

� � Design Document Setup 

The Design Document Setup command brings you to the Design Document Setup window. From 
this window you can modify the document size and change the paper orientation settings. 

  

� � Design Preview (Layout Only) 

The Design Preview command shows you a preview of what your work will look like after it is 
printed out. 

  

� � Print 

The Pr int command prints your work. It will prompt you with printing options before printing.  
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Edit Menu 

The following is a list of all the commands found on the Edit drop-down menu. 

� � Undo 

Use the Undo command to undo the last action. 

  

� � Redo 

Use the Redo command to redo an undone action. 

  

� � Cut 

Use the Cut command to cut a selected item and place it in the clipboard. 

  

� � Copy 

Use the Copy command to make a copy of a selected item and place it in the clipboard. 

  

� � Paste 

Use the Paste command to paste an item from the clipboard to a project. 

  

� � Clear  

Use the Clear  command to clear away a selected item. 

  

� � Select All  
Use the Select All command to select all items on the current page of a project.  
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Favorites Menu 

From within the Designer, this drop-down menu displays the list of graphics and images that are on 
your Favor ites list. You can select one of the images or graphics on the list to add it to your 
project. 

There is also a Favor ites drop-down menu at the Garden Workbench. From there you can add 
plants and images to the Favor ites list. Garden Workbench Favorites List. 
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Document Menu 

The following is a list of all the commands and menus found on the Document drop-down menu. 

� � Hide Margins 

Use the Hide Margins command to hide the margins if they are showing. If they are not showing, 
this command will show them. 

  

� � Grid 

Use the Gr id side menu to access the Show Gr id, Snap to Gr id, Gr id Color  and Gr id Spacing 
commands. 

  

� � Rulers 

Use the Ruler  side menu to access the Show Hor izontal Ruler  and Show Ver tical Ruler  
commands. These commands will display the horizontal or vertical rulers on the border of the 
window if they are not already shown. If they are already showing and you choose one of these 
commands, it will hide the appropriate ruler. 

  

� � Guides 

Use the Guides side menu to access the Snap to Guides, Erase Guides, Copy Master  Guides and 
Guide Color  commands. 

  

� � Measurement Units 

Use the Measurement Units side menu to select what type of measurements to use on the rulers. In 
the side menu you have the options of using Inches, Points, Centimeters or M illimeters. When 
you select one of the options, it changes the measurement markings on the rulers that are on the 
border of the window. It also changes the measurement units used in the I tem Proper ties, Gr id 
Spacing and Shadow Offset windows. 

  

� � Previous Page 

Use the Previous Page command to "flip" to the previous page in a project. 

  

� � Next Page 

Use the Next Page command to "flip" to the next page in a project. 

  

� � Master Page 

Use the Master  Page command to go to the master page if you are not already on it. If you are 
already on the master page, you will go back to the normal pages of your project. 
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� � Omit Master Page 

Use the Omit Master  Page to omit the master page background on the current page on which you 
are working in your project. 

  

� � Insert Pages 

Use the Inser t Pages command to bring up the Inser t Pages window and insert pages into a 
project. 

  

� � Remove Page 

Use the Remove Page command to remove the current page of your project. 

  

� � Zoom 

Use the Zoom side menu to access the Fit to Window, Page Width, Fit Height, and Actual Size 
commands. These four commands are also available on the Control toolbar. There is also a list 
where you can zoom by percentage on this menu. 

  

� � Erase Template (Template Only) 

Use the Erase Template command to erase everything on a template. 

  

� � Set as Global Defaults 

Use the Set as Global Defaults command to set the current settings as your global defaults from 
that point on. You can always change the global settings again in the future.  
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Item Menu 

The following is a list of all commands and menus found on the I tem drop-down menu. 

� � Fill  
Use the Fill side menu to modify the fill color of selected items. From the side menu you can select 
Select New Fill Color , Copy Selected Fill Color  and Paste Fill Color . When you select Select 
New Fill Color , it will take you to the Color  Selection window where you can choose a new fill 
color. When you choose Copy Selected Fill Color , it will copy the fill color of a selected item and 
copy it to the clipboard. When you select Paste Fill Color , it will paste the fill color in the 
clipboard to selected objects. From the Fill side menu you can also indicate whether an objects 
background should be Transparent or Solid. If an items background is marked to be transparent, 
then no fill color will show and items behind the object in the "stack" will show through when 
placed behind the transparent item. If the item is marked solid, the item will block items behind it 
and have a fill color. From the Fill side menu you can also select Graphic Has Transparency and 
Graphic Transparent Color . These control the transparency options of a graphic. 

  

� � Pen 

Use the Pen side menu to access the Select L ine Color , Copy Selected L ine Color  and Paste L ine 
Color  commands. When you select Select L ine Color , it will take you to the Color  Selection 
window where you can choose a color. When you select Copy Selected L ine Color , it will copy 
the line color of the item you have selected to the clipboard. When you select the Paste Selected 
L ine Color , it will apply the line color on the clipboard to selected items. 

  

� � Line Width 

Use the L ine Width side menu to adjust the width of lines in a project. 

  

� � Line Style 

Use the L ine Style side menu to adjust the style of lines in a project. You have the choices of Solid, 
Dashed, Dotted, Dash-dot and Dash-dot-dot. 

  

� � Align Items Horizontally 

Use the Align I tems Hor izontally side menu to choose to align selected items either horizontally 
Along Top, horizontally Along M iddle or horizontally Along Bottom. 

  

� � Align Items Vertically 

Use the Align I tems Ver tically side menu to choose to align selected items either vertically Along 
Left, vertically Along Center  or vertically Along Right. 

  

� � Rotate 90 Deg Clockwise 

Use the Rotate 90 Deg Clockwise command to rotate selected items ninety degrees clockwise. 
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� � Rotate 90 Deg Counter-clockwise 

Use the Rotate 90 Deg Counter -clockwise command to rotate selected items ninety degrees 
counter-clockwise. 

  

� � Rotate 180 Deg 

Use the Rotate 180 Deg command to rotate selected items one hundred and eighty degrees. 

  

� � Move to Front 

Use the Move to Front command to move selected items to the top layer in the "stack" of items in 
a project. 

  

� � Shuffle Up 

Use the Shuffle Up command to move selected items one layer up in the "stack" of items in a 
project. 

  

� � Shuffle Down 

Use the Shuffle Down command to move selected items one layer down in the "stack" of items in a 
project. 

  

� � Move to Back 

Use the Move to Back command to move selected items to the bottom layer in the "stack" of items 
in a project. 

  

� � Group 

Use the Group command to group selected items. 

  

� � Ungroup 

Use the Ungroup command to ungroup selected items. 

  

� � Shadow  

Use the Shadow side menu to modify and add shadows to items. You have the option to have No 
Shadow or you can select one of the following for the placement of the shadow: Bottom Right, 
Bottom Left, Top Left and Top Right. You can also use the side menu of the Shadow Color  
selection to access the Select New Shadow Color , Copy Shadow Color  and Paste Shadow Color  
commands. Select Select New Shadow Color  to go to the Color  Selection window and select a 
color for the shadows of a selected item. Select Copy Shadow Color  to copy the shadow color of a 



 14

selected item and put it on the clipboard. Select Paste Shadow Color  to take a shadow color from 
the clipboard and apply it to selected items. You can also access the Shadow Offset window from 
the Shadow side menu. 

  

� � Lock 

Use the Lock command to lock selected items. This will lock them in their current state and they 
cannot be modified until you unlock them. 

NOTE: To select a locked item, you must hold down the CTRL key while clicking on it. 

  

� � Unlock 

Use the Unlock command to unlock selected items. 

  

� � Format Picture 

Use the Format Picture side menu to select how you would like selected images and graphics. The 
three options you have are Size to Rectangle, Crop and Fill and Stretch. You can also find these 
three options on the fill tab of the Proper ties window. 

NOTE: You cannot use the Stretch option to resize Horticopia pictures. 

  

� � Properties 

Use the Proper ties command to bring up the Proper ties window for selected items. From the 
Proper ties window you can adjust many aspects of items. 

  

� � Set Defaults from Item 

Use the Set Defaults from I tem command to use the configurations for a selected item as the 
default settings for your current session.  
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Text Menu 

The following is a list of all commands found on the Text drop-down menu. 

� � Font 

Use the Font command to select what font you would like to use. 

  

� � Increase Font Size 

Use the Increase Font Size command to increase the font size in increments. 

  

� � Decrease Font Size 

Use the Decrease Font Size command to decrease the font size in increments. 

  

� � Size Text to Box 

Use the Size Text to Box command to re-size your text so that it takes up most of the space in it's 
text box. Here is an example of how this command works. 

 

Here I have some small text in a text box. If I adjust the text size range to accomodate for bigger 
text and then select Size Text to Box, it will look like this. 

 

It has re-sized the text to better fit the box. 

  

� � Text Size Range 

Use the Text Size Range to set the maximum and minimum font sizes to be used when using the 
Size Text to Box command. 
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� � Bold 

Use the Bold command to make text appear  bold-faced. 

  

� � Underline 

Use the Under line command to make text appear underlined. 

  

� � Italic 

Use the I talic command to make text appear in italics. 

  

� � Strikethrough 

Use the Str ikethrough command to make text appear with a line going through it. 

  

� � Align Left 

Use the Align Left command to align text to the left side of a text box. 

  

� � Align Center  

Use the Align Center  command to align text to the center of a text box. 

  

� � Align Right 

Use the Align Right command to align text to the right side of a text box. 

  

� � Align Top 

Use the Align Top command to align text to the top of a text box. 

  

� � Align Middle 

Use the Align M iddle command to align text to the middle of a text box. 

  

� � Align Bottom 

Use the Align Bottom command to align text to the bottom of a text box. 

  

� � Barcode Format 

Use the Barcode Format side menu to make adjustments to barcode properties. Information on 
barcodes. 
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� � Text Format 

Use the Text Format side menu to set up text formats for a text box. With text formats, you can 
modify the way dates or numbers are displayed. The text format property must be applied to a 
whole text box or field. In the Text Format side menu, you can choose from one of the pre-
existing text formats or you can create your own by selecting Custom. Detailed Text Format 
Information. 

NOTE: Text format is not effective in text boxes with RTF or selected embedded formats. The text 
box must be set for normal text. If you try to change the text mode setting of a formatted text box 
without selecting "no formatting", it will not change the text. 
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Help Menu 

The following is a list of commands found on the Help drop-down menu. 

� � Designer Help 

Use the Designer  Help command to bring up the help program for the Designer. 

  

� � Quick Tours 

Use the Quick Tours command to initiate the quick tours in Horticopia. These tours can help you 
learn some of the basic functions of the Designer. 

  

� � System Parameters 

Use the System Parameters to see a summary of your system characteristics. This information is 
useful for analyzing problems you may experience. 

  

� � http://Horticopia.com/ 
Use this command to log-on to our website. 

  

� � About Designer 

Use the About Designer  command to display information regarding the Designer.  
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Windows 

Color Selection Window  

 

This is the Color  Selection window. It is used to modify and select colors. You can choose one of 
the basic colors on the left or you can use the right side of the window to create and modify your 
own colors. Then you can save your colors in the custom colors palette. You will access this 
window from several different areas whenever you are selecting a color. When you create custom 
colors, the set that you have created will always be available whenever this window appears.  
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Custom Line Width Window  

 

This is the Custom Line Width window. It is used to adjust the width of lines in a project. You can 
access this window from the Line Width side menu located in the I tem drop-down menu or you 

can press the Line/Border Width button  on the Control toolbar.  
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Design Document Setup Window  

 

This is the Design Document Setup window. You can access this window from the File drop-
down menu. From this window you can modify the document size and change the paper orientation 
settings. You can also access the Page Setup window.  
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Grid Spacing Window  

 

This is the Gr id Spacing window. It is used to adjust the spacing measurements in a grid. This 
menu can be accessed from the Gr id side menu located in the Document drop-down menu.  
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Insert Pages Window  

 

This is the Inser t Pages to Layout window. You can add pages to a project before or after the 
current page on which you are working. This window can be accessed through the Inser t Pages 

button  on the Pages toolbar or in the Document drop-down menu.  
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Item Properties Window  

This is the I tem Proper ties window. You can access this window several ways. You can select an 
item or items and go to the Proper ties selection found on the I tem drop-down menu, you can 
double-click on an unselected object or you can hold down the control button and double-click on a 
selected item. There are many options involving this window. The following is a list of the tabs of 
the I tem Proper ties window. 

� � Position Tab 

 

You can use the Position tab to modify the exact location of an item. You can also modify the size 
and rotation of an item. There are also two boxes that can lock the item or mark it as non-printable. 

  

� � Attr ibutes Tab 
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You can use the Attr ibutes tab to modify the types of lines and borders and also to modify shadow 
options for items. 

  

� � Field Tab (Layout Only) 

 

You can use the Field tab to control the information that will be displayed in a field from this tab. 
You can also change the style in which the field is displayed in the Designer. 
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� � Format Tab 

 

You can use the Format tab to adjust the type of text to use in a text box, modify barcode options 
and modify Text Format options. Barcodes. Types of text. 

  

� � Fill Tab 

 

You can use the Fill tab to control fill , picture re-sizing and graphic transparency options. 
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� � Text Tab 

 

You can use the Text tab to control the different properties of text. You can control the font, text 
size, text style, alignment and fit text to box options.  
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Shadow Offset Window  

 

This is the Shadow Offset window. You can use this window to modify the offsets of shadows in a 
project. This window can be accessed through the Shadow Offset command in the Shadow side 
menu located in the I tem drop-down menu.  
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Toolbars 

Standard Toolbar 

This is what the Standard Toolbar  looks like this. 

 

The following are the buttons found on the Standard Toolbar . 

  

� � Save 

Use the Save button  to save your work. 

NOTE: This button will only be available after you have saved your work at least once. 

  

� � Preview Design (Layout Only) 

Use the Preview Design button  to see a preview of the layout that you have created. 

  

� � Print 

Use the Pr int button  to print your work. 

  

� � Cut 

Use the Cut button  to cut an item and put it on the clipboard. 

  

� � Copy 

Use the Copy button  to copy an item to the clipboard. 

  

� � Paste 

Use the Paste button  to paste an item from the clipboard. 
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� � Clear  

Use the Clear  button  to delete selected items. 

  

� � Undo 

Use the Undo button  to undo the last action. 

  

� � Redo 

Use the Redo button  to redo the last edit action. 

  

� � Display Help 

Use the Display Help button  to display the help window.  
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Formatting Toolbar 

This is what the Formatting toolbar looks like. 

 

The following are the buttons found on the Formatting toolbar. 

  

� � Font Selection 

Use the Font Selection menu  to change the font of text in a project. Click 
on the arrow to select from a list of fonts. 

  

� � Font Size 

Use the Font Size menu  to change the size of text in a project. Click on the arrow to 
select from a list of font sizes or in the box type the desired font size. 

  

� � Font Style 

Use the Font Style buttons  to change the style of text in a project. You have the 
choice of making the text bold-faced, in italics or underlined. 

  

� � Font Color  

Use the Font Color  button  to change the color of text in a project. Click on the arrow and 
you will get three selections: Select New Font Color , Copy Selected Font Color  and Paste Font 
Color . Select Select New Font Color  to go to the Color  Selection window and choose a color. 
Select Copy Selected Font Color  to copy the color of selected text and place it on the clipboard. 
Select Paste Font Color  to apply the color on the clipboard to selected text. 

  

� � Increase/Decrease Font Size 

Use the Increase Font Size  and Decrease Font Size buttons  to increase the font size in a 
project in increments. 
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� � Size Text to Box 

Use the Size Text to Box button  to make text resize to fit the text box that it 
is in. 

  

� � Align Left/Center/Right 

Use the Align Left button  to align text to the left side of a text box. 

Use the Align Center  button  to align text to the center of a text box. 

Use the Align Right button  to align text to the right side of a text box. 

  

� � Align Top/Middle/Bottom 

Use the Align Top button  to align text to the top of a text box. 

Use the Align M iddle button  to align text to the middle of a text box. 

Use the Align Bottom button  to align text to the bottom of a text box.  
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Designer Toolbar 

The Designer  toolbar looks like this. 

 

The following are the buttons found on the Designer  toolbar. 

  

� � Pointer  

Use the Pointer  button  to switch back to your normal pointer and select objects. 

  

� � Text Box 

Use the Text Box button  to create a text box in a project. 

  

� � Field (Layout Only) 

Use the Add a Field button  to create a field box in a project. 

  

� � Graphic 

Use the Add a Graphic button  to add a graphic to a project. 

  

� � Line 

Use the L ine button  to create a line in a project. 

  

� � Rectangle 

Use the Rectangle button  to create a rectangle in a project. 

NOTE: You can hold down the shift key while dragging the rectangle to draw a square. 

  

� � Rounded Rectangle 

Use the Rounded Rectangle button  to create a rounded rectangle in a project. 

NOTE: You can hold down the shift key while dragging the rectangle to draw a square. 
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� � Ellipse 

Use the Ellipse button  to create an ellipse in a project. 

NOTE: You can hold down the shift key while dragging the ellipse to draw a circle. 
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Control Toolbar 

The Control toolbar looks like this. 

 

The following are the buttons found on the Control toolbar. 

  

� � Fill Color  

Use the Fill Color  button  to change the fill color of things like shapes. 

  

� � Pen (Line) Color  

Use the Pen (L ine) Color  button  to adjust the color of lines. 

  

� � Line Border Width 

Use the L ine Border  Width button  to add a border to items and to change the width of 
borders and lines. 

  

� � Add a Shadow  

Use the Add a Shadow button  to add shadows to items and to change the settings for 
shadows. 

  

� � Group and Ungroup Selected Objects 

Use the Group Selected Objects  and Ungroup Selected Objects buttons  to group or 
ungroup items that you have selected. 

  

� � Move to Front or Back 
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Use the Move to Front  and Move to Back buttons  to move selected items to the top or 
the bottom layer of the "stack" of items in a layout. 

  

� � Shuffle Up or Down 

Use the Shuffle Up  and Shuffle Down buttons  to move selected items up or down a 
layer in the "stack" of items. 

  

� � Zoom In or Out 

Use the Zoom In  and Zoom Out buttons  to zoom in or zoom out on the view of your 
work. 

  

� � Page Zoom Adjustments 

Use the Show Actual Size button  to change the view of your work so that your project will 
appear on the screen the same size as it will when you print it out. 

Use the Zoom to Fit Page button  to zoom so that you can see all of the current page in the 
window. 

Use the Zoom to Fit Page Width  button to zoom so that the page width takes up the entire 
width of the window. 

Use the Zoom to Fit Page Height  button to zoom so that the page height takes up the entire 
height of the window. 
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Pages Toolbar (Layout Only) 

This is what the Pages Toolbar  looks like. 

 

The following are the buttons found on the Pages Toolbar . 

  

� � Previous Page 

Use the Previous Page button  to "flip" to the previous page of a project. 

  

� � Next Page 

Use the Next Page button  to "flip" to the next page of a project. 

  

� � Switch to/from Master Page 

Use the Switch to/from Master  Page button  to go to the master page and modify it. If you are 
already at the master page, this button will bring you back to the normal pages in the project. 

  

� � Show/Hide Page Margins 

Use the Show/Hide Page Margins button  to show or hide the margins on a project. If the 
margins are showing, this button will hide the margins. If the margins are hidden, this button will 
show the margins. 

  

� � Insert Pages 

Use the Inser t Pages button  to insert pages into a project. 

  

� � Remove Current Page 

Use the Remove Current Page button  to remove the current page from a project.  
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Working with the Designer 

Making Items Line Up 

The following are the topics discussed in this section: 

1. Grid 

2. Guidelines and Snap to Guides 

3. Horizontal and Vertical Alignment 

� � Grid 

In the Designer, you have the option of using a grid to help you line up items or to help you with 
the placement of items that you are working with. In the Document drop-down menu is a selection 
that says Gr id. When you place your pointer over this selection, a side menu pops up with several 
options. 

 

If you click on the Show Gr id command, it will show you a grid that is helpful for measuring 
distances or lining up items on a page. If you have the grid already showing and you click on this 
command, it will hide the grid. You can also control the spacing of the grid with the Gr id Spacing 
selection. The Gr id Color  selection allows you to control the color of the grid. The Snap to Gr id 
command makes the items that you move around on the page move in the increments of the grid 
spacing so it is easier to put items in the same line. If you already have this option selected and you 
click on it again, it will disable this function. 

  

� � Guidelines and Snap to Guides 
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While working on a project, it might be useful to use Guides. Guides are horizontal or vertical 
lines that you can use to line items up on a page. They are a strictly visual tool and do not print. To 
create a Guide, you must simply click on the ruler that is on the border of the Designer window. 

 

If you click on the ruler that runs horizontally across the top of the screen, you will receive a 
horizontal Guide. If you click on the ruler that runs vertically along the left side of the screen, you 
will receive a vertical Guide. After you click on the ruler, move your mouse pointer into the 
project. You will notice that a straight line, or Guide is going along with your pointer. When you 
click again, it will place the Guide. You can now use it as a visual tool to place items. 

If you wish to move a Guide again, simply click on the Guide outside the project area (the gray 
area) and it will move with your mouse pointer. Click again to place the Guide. 

If you wish to make the Guides disappear, you can either move the guide out of the work area or 
you can go to the Document drop-down menu. In the Guides selection there is an Erase Guides 
command that will erase the Guides. 
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There are also several other options in this menu. If you wish, you can select the Snap to Guide 
command. This makes your items easier to place directly against the Guides. With this option 
selected, the items you move will "snap" to the Guides you have placed. When you wish to turn 
this function off, simply click on the command again. 

When you are creating a multiple page layout, each page you have has it's own set of Guides. If 
you wish, you may also add Guides to your master page. If you have Guides on your Master  
Page, and you select Copy Master  Guides, it will copy these to the current page that you are 
working on. 

With the Guide Color  you can simply modify the color of the Guides. 

  

� � Horizontal and Vertical Alignment 

There is also an option available that allows you to line up different items that you are working 
with. When you have the items you wish to line up selected, go under the I tem drop-down menu. 
In this menu you will find two selections; Align I tems Hor izontally and Align I tems Ver tically. 
With the items selected you can go to these options and another side menu pops up. You can then 
choose to align the objects as follows: horizontally Along the Top, Along the M iddle or Along 
the Bottom or vertically Along the Left, Along the Center  or Along the Right. When you click 
on one of these options, it will line the selected objects based on the option you chose. 

Here is an example of how these commands work. 
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Here I have two pictures in my layout. After selecting both of them and choosing align vertically 
along the middle, they look like this. 
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Now they are both lined up on their centers. If I would have chosen align horizontally along the top 
they would have looked like this. 
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Now they are lined up along their tops. 
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Ordering and Groups 

The following are the topics discussed in this section: 

1. Shuffle Up/Down and Move to Front/Back 

2. Groups 

� � Shuffle Up/Down and Move to Front/Back 

When you add items to a project, it is like you are adding various layers on top of one another. 
With the Move to Front, Move to Back, Shuffle Up and Shuffle Down commands 

 you can organize the order in which the items are "stacked". These commands are 
found in the Control toolbar or the I tem drop-down menu. 

NOTE: The view of an item is blocked by all the items that overlap it and that are "stacked" above 
it. Also the item blocks out the view of any items below it that it overlaps with. 

When you select an item, you can click on the Move to Front button  to move the item so it is 
in the foremost layer. Now when you move that item to overlap any other item, it will block the 
view of the other item since it is "stacked above it. 

You can also click on the Move to Back button  to move a selected item to the bottom most 
layer. Now when you move the item to overlap another, it will be hidden by the other items that are 
"stacked" above it. 

The Shuffle Up button  moves a selected item one layer above it's current position in the 
stack. 

The Shuffle Down button  moves a selected item one layer below it's current position. 

  

� � Groups 

You also have the option of grouping and ungrouping items that you are working with. When you 
group two or more selected items together, they essentially behave like one item. You may group 
and ungroup items using the Group Selected Objects and Ungroup Previously Selected Objects 

buttons  . 

To group several items together, you must first select all of the items that you wish to group. To do 
this, hold down the shift key while you click on all the objects you wish to group. After all of the 

items you wish to group are selected, click on the Group Selected Objects button  . When 
you group several items, it moves the group to the front layer although the items in the group 
maintain their relative order.You may then move the group to the desired position. If you wish to 
ungroup items that you have previously grouped together, you may do so by selecting the item with 

the grouped objects and clicking on the Ungroup Previously Grouped Objects button  . 
These two selections can be found on the Control toolbar or in the I tem drop-down menu. 

NOTE: You cannot resize group items that are grouped. You can select several objects at the same 
time and resize them but not a group. If you ungroup a group, any grouped objects within the group 
will also be ungrouped. 
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NOTE: When you select more than one item, only the Group Selected Objects button will be 
available and the Ungroup Previously Selected Objects will be grayed out. When you select an 
item that was previously grouped, only the Ungroup Previously Selected Objects button will be 
available and the Group Selected Objects will be grayed out. 
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Pictures and Graphics 

The following are the topics discussed in this section: 

1. Picture Formats - fill and crop and fit to rectangle 

2. Picture Captions (Layout only) 

3. Stretch Format - not for Horticopia pictures 

4. Adding Graphics to the Favorites Menu 

� � Picture Formats - fill & crop and fit to rectangle 

When you are using Horticopia's pictures in a project, you cannot change the image (i.e. by 
stretching the image which would distort it). When working with Horticopia's pictures there are two 
available options for resizing the photos. You must first select the picture on which you wish to 
change the resizing options. In the Fill tab of the I tem Proper ties window, you will find the 
options Fill and Crop and Fit to Rectangle. You can access this window by double clicking on the 
picture or by going to the Proper ties command in the I tem drop-down menu while the picture is 
selected. 

 

NOTE: When you are working with graphics, you can stretch the images. In this case, the Stretch 
option will not be grayed out. 

One option that you have when working with a picture is to have the Fit to Rectangle selection 
chosen when you resize it. When you increase the size of the picture, it does not fit the picture 
exactly to the size of the box you drag when you resize it. Instead it snaps back to a close size that 
maintains the proportions of the original picture. This allows you to resize and preserve the original 
image. 

Here is an example of how this works. 
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Here I have an image that I want to enlarge. When I use the Fit to Rectangle selection when I re-
size it, it will look something like this. 

 

In this case the image is exactly the same except for the fact that it is bigger. 

The other option is to have the Fill and Crop selection chosen when you resize the picture. Now 
when you resize it, the picture fills up the entire box that you have dragged. In this instance, in 
order to preserve the picture, the computer must crop out certain parts of the picture that cannot fit. 

Going back to the demonstration, the Fill and Crop selection for the same picture would look 
something like this. 
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In this case, I have dragged the image so that it is longer. It has maintained the graphic's appearance 
but has cropped parts of the graphic in order to do this. 

  

� � Picture Captions (Layout Only) 

When working with layout and adding pictures, you have the option of adding captions with them. 
From the Garden Workbench, go to the File drop-down menu and select Document Setup. The 
Document Setup window will now appear. Click on the layout tab and the window will look like 
this. 

 

At the top you can control the font in which the caption of the picture will be displayed. Below that 
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to the right you can control what the caption says. You can check the boxes of the items you wish 
to be displayed in the caption. For Example: If I had the above boxes checked, the caption will 
display the botanical and cultivar name for the plant. If you uncheck all the boxes, there will be no 
caption information displayed. After you have checked the boxes you wish and have clicked OK, 
there will be a caption displaying the checked information when you add pictures to your layout. 

  

� � Stretch Format - not for Horticopia pictures 

As is mentioned above, you cannot stretch Horticopia pictures when resizing. When you have 
added other graphics, however, you may stretch when resizing. You can adjust this setting in the 
I tem Proper ties window. 

 

In the case of editing graphics that you have added, the Stretch option will be available. After you 
select this option, you simply resize the graphic. 

Continuing from the demonstration in the "Picture Formats - fill & crop and fit to rectangle" 
section, here is how the same graphic might look when stretched. 
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In this case the image has not remained the same but has been warped as a result of the stretching. 

  

� � Adding Graphics to the Favorites Menu 

It is also possible to add graphics to your Favor ites menu. From the Garden Workbench go to the 

Favor ites drop-down menu and select Add Graphic  . You can also do this 

by clicking on the Add Graphic button  at the top of the window. The program will then 
prompt you to locate and name the file. Once you have located and name the file and clicked OK, it 
will appear on your favorites menu. If you wish to use a picture in your Favor ites menu, in the 
Designer simply select the Favor ites drop-down menu and select your picture. Then just drag a 
box on the project and your picture will appear. 
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Saving and Retrieving Your Work 
The following are the topics discussed in this section: 

1. Save Design and Save Design As 

2. Open 

3. Favorites 

� � Save Design and Save Design As 

When you are working on a layout and you wish to save your work, you may do so 
using the "save design" or "save design as" function. You can find these options 
under the File drop-down menu. The first time you save your work, you must 
select "save design as" and then click on the "save layout" option so that you can 
select a name for the file. After you select "save as" and click on "save layout", 
you will see a screen that looks like this. 

 

You must then type in a name and click OK. This saves your work under the 
selected name. If you choose the "save design as" option again on this project, it 
will save again as a totally different file, independent of the previous save. 

When you are working on a layout that has been previously saved and you would 
like to save your progress, you may do so using the "save design" option in the 

File drop-down menu or the "save design" button  located at the top of the 
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screen. This simply saves the changed layout over the previously saved one. 

  

� � Open 

When you have previously saved a layout and you wish to work on it again or use it again, you may 
do so with the Open command. The Open command can be found in the File drop-down menu or 

you may use the Open button  located at the top of the screen. After choosing the Open 
command and clicking on "open layout", you will a screen that looks like this. 

 

You will then be able to choose which layout you wish to open and click the Open button. 

  

� � Favorites 

Within Horticopia, you have the option of adding pictures to your Favor ites list. After you add 
pictures to your Favor ites list, these pictures will have something like a bookmark on them and can 
be easily and quickly accessed. There are actually two Favor ites drop-down menus. You can add 
plants from the Favor ites drop-down menu that shows with the Garden Workbench. When you 
find a picture in Horticopia that you would like to add to your Favor ites, you should double click 
on the picture to open it and then go to the Favor ites drop-down menu and select Add Picture. 
When you do this, a screen will pop up that looks like this. 
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In the name field you can select a name for the picture to be known as or leave the name that 
automatically is entered into the name field. After entering a name, click OK and the tree now will 
appear in the Favor ites drop-down menu. 

When you wish to add a picture from your Favor ites list to a project, you may do so from the 
Designer by opening the Favor ites drop-down menu (the Favorites drop-down menu that you can 
access while in the Designer) and selecting the picture you would like to add. After you have 

selected the picture you would like to add, the mouse pointer will change to look like this  . 
You then must then move the mouse over the project, hold down the left mouse button and make a 
box which will become your picture after you release the mouse button. 

In addition to adding Horticopia pictures to your Favorites list, you can also add graphics from 
outside of Horticopia. Adding graphics to your Favorites list. 
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Working with Defaults 

The following are the topics discussed in this section: 

1. Changing Defaults 

2. Set Defaults from Item 

3. Set as Global Defaults 

When you are working on a project, you will be able to change and set the default configurations 
applied to the items you will be working with. 

� � Changing Defaults 

First of all, you can change the general default settings within the Designer. When nothing is 
selected in the Designer and you choose different settings from the various toolbars, those settings 
now become the default settings that will apply to everything you do from then on in your current 
session. For Example: If you have nothing selected in your project and you choose a purple fill 
color, all the items that you create from then on that have a fill color to them will be filled with 
purple. The next time you open Horticopia, these new configurations will disappear. 

  

� � Set Defaults from Item 

In the Designer you can set the default settings of items you create from a pre-existing item. When 
you have an item selected and you choose the Set Defaults from I tem command, it applies the 
settings of the selected item to the items you create in the future during your current session. You 
can find the Set Defaults from I tem command in the I tem drop-down menu at the top of the 
window. 

  

� � Set as Global Defaults 

In the Designer you can set the general default settings to a specific configuration for all future 
sessions. If you do this, whenever you open the Designer it will start with the settings that you set. 
When you have the settings of the Designer configured how you would like them to be set in the 
future, click on the Set as Global Defaults command. This is located in the Document drop-down 
menu at the top of the window. After you have clicked on this, your current settings should be set 
this way when you re-open the Designer for future sessions. 

NOTE: You can always change your general default settings through this same process again if 
you wish. 
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Working with Fields (Template Only) 

The following are the topics discussed in this section: 

1. Horticopia Data 

2. Horticopia Pictures and Graphics 

3. Herbaceous Fields and Woodies Fields 

4. Information Blocks 

5. Garden Studio Tab Fields 

6. Special Fields - joined and graphical 

7. Previewing with Sample Data 

When creating or editing templates, you can add fields to your project. A field specifies a certain 
type of information and inserts that type of data depending on what plant you are using with the 
template. For example: If I am going to use a template in which there is the field 'botanical name' 
and I use it to produce a sign of a plant, it will look up the plants botanical name and write that 
information in that field. The information written in that field will change according to the different 
plants you use. 

� � Horticopia Data 

When you want to insert a field into a template, you must simply click on the Add Field button 

 . The mouse pointer will then change to look like this  . You then must hold down the left 
mouse button and drag a square. When you have made the field as big as you want it, release the 
left mouse button and the Inser t a Field window will pop up. 

  

There are many different types of information that you can have inside the field box. Most of these 
can be found under the folder 'common fields' that is located in that window. Once you find the 
information that you wish to be displayed in the field, click on it and select OK. The creation of 
your field is now complete. 
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� � Horticopia Pictures and Graphics 

There is also the possibility of creating fields that will show pictures. Create a field as is instructed 
above and when the Inser t a Field window pops up, scroll down to the folder labeled 'plant 
pictures' and pick the type of plant picture you wish to have on your template. Click OK and the 
creation of your field with a picture is now complete. 

There is also the option of using graphics provided by Horticopia in your templates. You can find 
these in the 'graphical fields' folder in the Inser t a Field window. 

  

� � Herbaceous Fields and Woodies Fields 

In the Herbaceous Fields and Woodies Fields folders, you can find fields that have to do with the 
characteristics that you can see for each plant from within the Garden Workbench. These fields 
both draw their information from the attribute list for a specific plant. 

  

� � Information Blocks 

In the Information Blocks folder you can find options for creating fields that contain data drawn 
from the tabs that you can access from the Garden Workbench. These fields can be used to insert 
specific data from the information found in these tabs. 

  

� � Custom  

In the Custom folder you will find fields that draw their data from the Custom tab found in the 
Information tab of the Plant Information window (only for use with the Author ing Module or 
Garden Studio). The Custom tab is meant to make it possible for users to enter in their own 
written data for a plant and use it in Garden Studio or in a layout (users cannot change the 
Hor ticopia tab in the Information tab because this information is generated from the search 
attributes). 

  

  

� � Garden Studio Tab Fields 

Some of the fields that you can create for the templates draw from data that you have entered for a 
specific plant. These are all located in the Garden Studio Tab Data, Garden Studio Tab Text 
and Garden Studio Tab Graphics folders. When you double-click on a plant in the Garden 
Workbench, there is a Garden Studio tab as well as the Information and Preview tabs. The 
Garden Studio tab contains boxes in which you can enter data. You can change the titles of these 
boxes and the values inside. When you go to make a field in a template, you have the option of 
making the field draw from the data that you have entered. The Garden Studio tab also contains 
another tab to insert graphics. 

For Example: In the Garden Studio tab, I can change the title of "User Text 1" to "Special Info". 
This changes all "User Text 1" box titles to "Special Info". Then in the "Special Info" box on a 
plant I wish to use in a template I type in "This is my special plant". When I go to create a field for 
my template, I can tell the field to draw from data I have entered by selecting "Special Info" in the 
Inser t a Field window. This will then draw from this information box and when I print the 
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template for my plant, "This is my special plant" will appear in the field. 

  

� � Special Fields - joined and graphical 
There are also options for fields that have multiple pieces of information in them. In the Inser t a 
Field window, you can find these fields in the Joined Fields folder. 

In addition to having Joined Fields there are also options for fields that display only in certain 
instances. These fields are called Graphical Fields. For Example: One of the Graphical Field 
options that Horticopia provides the user, is called "Birds". If you add this field to a layout, it 
displays a picture of a bird IF in the information for that plant it states that the plant attracts birds . 
This is just one example of the field options available in the Graphical Fields folder. 

  

� � Previewing with Sample Data 

Once you have a template partially or fully set up, it is often desirable to view what it would look 
like. To do this, simply select the fields of which you wish to see a preview and click on the Show 

Sample Field Data button  . The button can be found on the Standard toolbar. The Designer 
then takes sample data and places it in the fields of the template. When you wish to remove all the 
sample data from the fields and go back to having the textured boxes with the field name and folder 
written, select the fields to which you wish to make this change and click on the Data Source 

button  . 
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Working with Multiple Pages (Layout 
Only) 

The following are the topics discussed in this section: 

1. Master Page 

2. Margins 

3. Inserting and Removing Pages 

4. Previous/Next Page 

5. Design Document Setup 

� � Master Page 

In the Layout Window you are given the option of making a Master  Page. The Master  Page 

button looks like this  and can be found on the Pages toolbar which looks like this 

 . It can also be found under Document drop-down menu. When you 
click on this icon, it opens up a blank page on the layout screen. You can set this screen up and it 
will appear as a background for all of the following pages that you have in your layout. When you 
are done modifying this page, you can click once more on the Master  Page icon which will take 
you back to the regular pages in your layout. Your master page should now appear as the 
background for all of the pages in your layout. You may modify the Master  Page further by 
clicking on the icon again. 

If you have a Master  Page set up for a layout and wish to omit this background on one or several 
of your pages, you may do so by going to the page or pages to which you wish to omit the 
background and selecting the Omit Master  Page option. This option can be found under the 
Document drop-down menu. 

  

� � Margins 

You can edit the measurements for the margins of a layout with the Page Setup button in the 
Design Document Setup window. You can find the Design Document Setup option in the File 
drop-down menu at the top of the window (this is a different window from the Document Setup 
window that you can access from the Garden Workbench). 

 

You can then click on the Page Setup button and edit the measurements for the margins in the 
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Page Setup box. 

 

NOTE: You can view or hide the margins on your project by clicking on the Show/Hide Margin 

button  or  (depending on whether the margins are currently hidden or showing). This 
command can also be found in the Document drop down menu. 

  

� � Inserting and Removing Pages 

Another option you have in the Layout window, is to insert or remove pages. When you wish to 

create more pages in your layout, you have simply to click on the Inser t Page icon  in the 
pages toolbar. You can also find this option in the Document drop-down menu. It will then prompt 
you to ask how many pages you wish to insert and whether you would like to insert them before or 
after the current page. 

 

After you make your selections click OK and it will complete the desired task. 
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You can also remove pages from your layout. You have simply to go to the page you wish to delete 

and click on the Remove Cur rent Page icon  . This is also available in the Document drop-
down menu. It will then remove the page of your layout that you are currently working on. 

  

� � Previous/Next Page 

While working on a project, you can cycle through the different pages of your project. In the Pages 
toolbar or the Document drop-down menu, you can click on the Page Up or Page Down icons 

 to "flip" to the next or previous page in your project. 

  

� � Design Document Setup 

The Design Document Setup command can be found in the File drop-down menu at the top of the 
window. 

 

From this window you can change the settings for the paper size, orientation and type. You can also 
enter into the Page Setup window from here. 
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Working with Text and Text Formats 

The following are the topics discussed in this section: 

1. RTF (Rich Text Format) Text 

2. Normal Text 

3. Mixed (Selected Embedded Formats) Text 

Within the Designer, you can change the type of text that you use in text boxes. You can change 
the text modes in the Format tab in the properties window for the text box you are working on. 

� � RTF (Rich Text Format) Text 

If you set a text box to use RTF text, you can have all different sizes, fonts, colors and styles within 
the same text box. RTF text mode is demonstrated in the box below. 

 

NOTE: You can only use the Size Text to Box  command when using normal 
text mode. You can find this command in the Formatting toolbar or in the Text drop-down menu 

  

� � Normal Text 
When you create a text box, it is automatically set to normal text mode. All of the text in the box 
must be the same style, font color and size when the text box is set to normal mode. Normal mode 
is demonstrated in the box below. 

 

  

� � Mixed (Selected Embedded Formats) 

When you set a text box to mixed (Selected Embedded Formats), the text must be of the same 
font and size but may vary in color and style. Mixed mode is demonstrated in the box below. 
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NOTE: When rotating text, only normal text mode can be used. If you rotate text that is in mixed 
or RTF mode, it will change to normal mode and take on the characteristics of the first character of 
text. Also, when using rotated text that has a transparent background, the box will appear to have a 
white background but will print as transparent. If a patterned background is used, it will show as a 
solid color but will print the background. 
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Barcode Information 
UPC-A 

UPC-A (Universal Product Code-A) is the most common UPC bar code for retail product labeling 
and is seen in most grocery stores across the United States. The symbology encodes a 12 digit 
numeric only number. The first six digits are assigned from the Uniform Code Council (UCC) in 
Dayton, Ohio, the next five digits are assigned by the manufacturer, and the final digit is a modulo 
10 check digit. The nominal height for the UPC-A bar code is one inch. The reduced size is 80% of 
the nominal size. 

  

UPC-E 

UPC-E (Universal Product Code-E) is also fixed length and is a compressed six digit code used for 
marking small packages including magazines and paperback books. UPC-E symbols are UPC-A 
symbols that have been zero suppressed (i.e. consecutive zeros are not included in the symbol). The 
printed value of the UPC-E code is a twelve digit code. The nominal height for the UPC-E bar code 
is one inch. The reduced size is 80% of the nominal size. 

  

EAN/JAN-13 

European Article Numbering/Japanese Article Numbering (EAN/JAN) 

The EAN/JAN-13 is fixed length and is similar to the UPC-A symbology, but encodes a 13th digit. 
The 12th and 13th digit define the country code. The code 00-04 and 06-09 are assigned to the 
United States. The nominal height for the EAN/JAN-13 bar code is one inch. The reduced size is 
80% of the nominal size. 

  

EAN/JAN-8 

The EAN/JAN-8 is fixed length and is similar to the UPC-E code, but includes two more digits for 
the country code. The nominal height for the EAN/JAN-8 bar code is one inch. The reduced size is 
80% of the nominal size. 
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Text Formatting Information 
When you choose Custom, a window will pop up asking you to enter in a custom format.  When 
typing in a format, there are several characters and character combinations of which you should 
know the meaning. 

If you enter a "yy" into the custom format box, it will display the year as a two digit number where 
you entered the "yy". If you enter a "yyyy" into the box, it will display the year as a four digit 
number where you entered the "yyyy". 

If you enter a "d" into the custom format box, it will display the day as a one or two digit number 
without a leading zero. If you enter a "dd" into the box, it will display the day as a one or two digit 
number with a leading zero if the number is only one digit. If you enter a "ddd" into the box, it will 
display the day as the three character abbreviation for the day of the week. If you enter a "dddd" 
into the box, it will display the full name of the day of the week. 

If you enter a "m" into the custom format box, it will display the month as a one or two digit 
number without a leading zero. If you enter a "mm" into the box, it will display the month as a two 
digit number with a leading zero if the number of the month is one digit. If you enter a "mmm" into 
the box, it will display the month as a three character abbreviation of the month. If you enter a 
"mmmm" into the box, it will display the name of the month in full. 

When entering the actual value for the text format, the computer recognizes certain patterns for 
dates. It recognizes for example the form "month/day/year" (with number values in place of the 
words). It also can recognize various other forms of writing the date. For Example: If I enter 
"3/25/04" as the actual value and then I write "mm-d-yyyy" as the text format, it will appear as "03-
25-2004". 

When working with numbers, there are several other characters to be familiar with. The character 
"#" represents any number and will not display leading zeros if the actual value of the field is not as 
big as the format. The character "0" represents any number but will display leading zeros if the 
actual value of the field is not as big as the format. For Example: If I enter "5555.5" into the field 
and enter the text format "$#,###.#0", it will display the value as $5,555.50.  
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Insert a Field Window (Template 
Only) 

 

This is the Inser t a Field window. You can use this window to select the type of information to be 

displayed in a field. This window can be accessed by clicking on the Inser t a Field button  .  
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Page Setup Window 

 

This is the Page Setup window. From here you can modify the paper size and source for printing. 
You can also modify the margin measurements and the paper orientation options. You can access 
this window from the Design Document Setup window.  
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